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SimLab Template Designer 

SimLab Designer 

SimLab Designer is a standalone application used for designing templates to be used for exporting 3D PDF 

files, as well as exporting Html5 (WebGL). SimLab Designer is used in SimLab Composer, and other 3D 

SimLab Plugins. In the PDF Settings window, Template tab, clicking the New or the Edit buttons will 

open SimLab Designer. 

SimLab Designer Toolbar 

The application toolbar includes the buttons shown and described below. 

 

 

New File Button 

Clicking this button will open the Page Size dialog 

box, where a user can input the page size, 

orientation, and resolution. This dialog can also be 

accessed from File menu, to change the page 

size/resolution. In the image shown on the right A4 

page size was selected, and the resolution was set 

to 72 dpi. Clicking the Ok button will create a new 

empty template file, and will display the page Fill 

Mode property on the left. If the property is not 

displayed select the page in the middle of the 

application window.   

Page Size 

In this dialog a user can choose the orientation of the created 3D PDF template page, to be Portrait or 

Landscape. The page size can also be selected from the drop down selection box, and in case of selecting 

Custom size the Width and Height boxes will need to be filled.  The size of the new page will also be 

displayed in PDF (inches) units. A user can change PDF pages’ resolution in this dialog. Increasing the 

resolution will increase the size of the generated 3D PDF file; improve the image quality, which will be better 

for printing.   
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SimLab Template Designer 

Fill Mode 

Fill Mode can be a Single Color, a Linear Gradient or an Image. If the Single Color fill is selected click the 

choose-button to display the Fill Color window, where you can select the fill color you want.  

 

 

If the Linear Gradient fill mode is selected, a default gradient will fill the page, and again clicking the choose-

button will display the Gradient Dialog where you can set the color and its gradient degree.   
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SimLab Template Designer 

In case of selecting the Image Fill Mode, the 

Image Source can be either From File, or 

From Dictionary. In case of image from file, 

click the choose-button to browse to a 

background image.  

 

 

 

For images from dictionary, the user has to input a Default Image, in case the dictionary value was not found 

in the defined location. As shown in the image bellow the user has defined ‘template background’ with an 

image value, in the Dictionary dialog.  Fill in the Dictionary keyword field with the name defined in the 

dictionary, and the Dictionary value will be automatically filled. For more information, go to SimLab Designer 

Dictionary section.  
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SimLab Template Designer 

Line Button 

Clicking this button will add a line to the template, in 

the chosen location. The line properties will appear 

on the left. The Start and End locations indicate the X, 

and Y coordinates of the line’s end points.  

Line Color enables users to change the color of a line, 

and Line Width to change its width. A user can pull 

any of a line’s end points on the template page to 

change its length and orientation.  

Rectangle Button 

Clicking this button then anywhere on a template page will create a rectangle, filled with single white color. 

Rectangle Properties  
Start Location; can be set by specifying the X and Y 

values of its location. The coordinates are those for 

the upper left point of the text bounding box. You 

can also drag the rectangle anywhere on the page, 

to set its location. 

Line Color and Line Width; can be used to set the 

color and width of the lines of the rectangle.  

Fill Mode; can either be Single Color or a Linear Gradient, as already described under the New File Button. 

The Opacity it is how transparent the filling of the object, in this case rectangle, is.  

Width and Height; these two values can be used to set the dimensions of the rectangle. Another way to do 

that is by dragging any of the handles of the rectangle on the page, which in turn will change the values in 

these fields.  
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3D Area Button 

3D Area is where the 3D model will be placed, in the exported 3D PDF file.  

3D Area Properties  

Start Location; can be set by specifying the X 

and Y values of its location. The coordinates 

are those for the upper left point of the text 

bounding box. A user can also drag the 3D 

area anywhere on the page, to set its 

location. 

 

Background Fill Mode; is where a user can set 

the background of the 3D model. The 

Background Fill Mode can be Transparent, 

Single Color, or an Image. If the Transparent 

fill is selected the 3D area’s background will 

show the fill of the template page.  

For Single Color mode click the choose-button 

to display the Fill Color window, where you 

can select the fill color you want. 

 

The Image fill mode requires browsing for an image file to be your 3D area’s background. 

The Width and Height of the 3D area can be changed by either setting values in these fields, or by dragging 

any of the handles of the 3D area on the template page.  
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Text Button 

To add text to your template page click this button, 

then click where you want to add the text on your 

template page. The Font Dialog window will open, 

and if it is your first time to click this button in this 

session, it will take few seconds to load the fonts.  

In Font Dialog you can input the text and choose its 

font type, size, color, and other properties. When 

satisfied click Ok, and the text will appear on your page. If you need to edit anything in the text, just double 

click it on the page and this will open the Font Dialog again. 

Text Properties  

Start Location; can be set by specifying the X and Y values for the text location. The coordinates are those for 

the upper left point of the text bounding box. A user 

can also drag the text box anywhere on the template 

page, to set these values. 

Background Color; is by default White. Click the 

choose button to open the fill color window to 

choose a new color.  

Opacity; if set to 0% then the text will be completely 

transparent, and the background fill will appear 

under the added text. If the user changes the 

Opacity of the Text to 100% the Text fill color will 

appear on top of the page color. Values between 0-

100% can also be specified for this property.  

Text Source; can either be form Text Editor, or From 

Dictionary. Text editor is the font dialog, mentioned 

earlier. Upon choosing text from dictionary, the 

properties dialog will change, as shown.  The user 

will need to input default text, in case the dictionary 

value was not found in the defined location.  Then 

input the already defined dictionary keyword, and its value will be filled automatically form the dictionary. 

For more information, go to SimLab Designer Dictionary section. 
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Action Type; links certain predefined actions to the text added to a template page. URL is one type of action, 

which links the added text to a certain web location. For more information, go to SimLab Behavior/Actions 

Support section.  

Image Button 

This button can be used to add an image to a 

template page. When a user selects this 

button and click anywhere on the page the 

Open Image dialog will automatically open 

to browse to an image file.  A user can also 

change the image file from the File Name 

property. 

Images can be used to show a company’s 

logo, or to represent different products in a 

3D PDF file. 

Image Properties  

Start Location;  can be set by specifying the X and Y values of its location, the coordinates are those for the 

upper left point of the text bounding box. 

A user can also drag the image anywhere 

on the page, to set these values. 

Image Source; can either be From 

File, or From Dictionary. In the From 

File option, by clicking the choose 

button on the side of the File Name 

text box, the Open Image dialog will 

appear. The user can select the image 

to add to the template page.  
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SimLab Template Designer 

Choosing image From Dictionary option, will 

change the properties dialog, as shown.  The user 

will need to input default image, in case the 

dictionary value was not found in the defined 

location.  Then inputs the already defined 

dictionary keyword and its value will be filled 

automatically form the dictionary. For more 

information, go to SimLab Designer Dictionary 

section. 

Keep Aspect Ratio check box; with image element 

already set on the template page with a specific 

size, checking this option will place the image, set in the dictionary, while keeping its original aspect ratio.  

Width and Height; these two values can be used to set the dimensions of the image. A user can enter values 

in these fields, or drag any of the handles of the image on the page, which in turn will change the values in 

these fields.  

Action Type; links certain predefined actions to the image added to a template page. Scene State is one type 

of action, which links the added image to a scene state/cameras in the exported 3D file. For more 

information, go to SimLab Behavior/Actions Support section.  

Zoom 

The Zoom drop down selection box can be used to set zoom percentage for viewing the PDF template page.  

Send Back & Bring Front 

When a user starts having more than one object on a template page, these two buttons can help arrange 

things, by sending some object to back and bringing others forward. 
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SimLab Designer Dictionary  

Users of SimLab designer can define their own 

dictionary. Values defined in dictionary can be used 

for automatic replacement of Text/Image 

components in templates.  

Selecting Dictionary from the Edit menu will open 

the Dictionary dialog. In the image shown to the 

right items were already added to the dictionary. Users can edit, delete, or 

add items to the dictionary. Items added in the dictionary can have text or image files values. In case of 

image file the user can navigate to it from the Insert Items dialog.  

To use the values defined in the dictionary 

the user has to specify the component(s) 

in the template(s) that will have its source 

form the dictionary. In the image shown 

to the right, the source for the logo image 

component is set to be From Dictionary.  

The Open Dictionary File button will 

embed values defined in the opened 

dictionary to the current values. Export 

Dictionary To File button will export the dictionary for sharing with others. Dictionary files extension is (*.df).  

Preferences  

Selecting preferences from the Edit menu will open its dialog, as 

shown in the image to the right.  In this dialog the user can set the 

unit grid size, and can choose to check the snap to grid option. 

Showing the grids on a template page, can be done by checking Grid 

under the View menu, short cut ‘G’. 
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SimLab Behavior/Actions Support 

SimLab Composer, and other 3D SimLab plugins support a number of predefined Actions that can be applied 

upon clicking Templates’ elements. Advanced users can write their own script to define new actions. Applied 

actions can be exported to 3D PDF files, as well as HTML (WebGl). 

Action Effect Required Fields 

URL Links 3D geometry OR Template element 
with the entered web address, that will be 
opened On Click.  

Url textbox; to include the web 
address. 

Message Box Displays a message box upon clicking 3D 
geometry OR Template element. The user 
needs to enter the Message and its Title. 

Title textbox; to include the 
message title. 
Message textbox; to include 
the message to display.  

Animation Play (in 
case of animation 
support) 

Plays scene’s animation upon clicking 3D 
geometry OR Template element. One 
animation is supported for a scene; 
(supported only in SimLab Composer) 

 
-------------- 

Animation Stop (in 
case of animation 
support) 

Stops playing scene’s animation upon 
clicking 3D geometry OR Template 
element; (supported only in SimLab 
Composer) 

 
-------------- 

Script Enables users to write their own script to 
be executed upon clicking 3D geometry OR 
Template element. 

Java Script dialog to include 
scripts to execute.  

Scene State Executes a scene state upon clicking 3D 
geometry OR Template element. Scene 
states can be selected by Name or Index. 
Scene States are equivalent to camera’s in 
3D SimLab plugins, so if the 3D SimLab 
plugin supports exporting cameras this 
field is applicable.  

Scene State Name, or Scene 
State Index; to include the 
name or index of the state 
depending on the option 
chosen in the By combo box.   

Multi Action Executes a number of actions upon clicking 
3D geometry OR Template element. 

described below 
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Multi Action Option 

Upon selection this action type, a user can enter a list of 

actions to be executed upon clicking a 3D geometry or a 

template element. The user can also change the order of the 

actions’ list, and the way they are executed.  

Swing; runs the actions’ list upon click in 

order, then backwards again. That is 

action_1, 2,3 …, then 3, 2, 1. 

Loop; runs the actions’ list upon click in 

order, then from start again. That is action_1, 

2,3 …, then 1, 2, 3. 

Random; runs the actions’ list upon click randomly.  

Run All; runs the actions’ list upon click in order one time.  

Actions can be executed in 3D PDF, and HTML files. 

 

 

 

 

 

 

 


